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    PREFÁCIO

    
        
        
            Por Ana Paula Gonçalves Serra

O conceito de teste pode ser definido como uma atividade que tem por objetivo verificar se o software produzido está de acordo com sua especificação e se satisfaz as expectativas do cliente. Teste de software é parte integrante do processo de Validação e Verificação (V&V) da Engenharia de Software. Sendo que verificação refere-se ao conjunto de tarefas que garantem que o software implementa corretamente uma função específica, e validação refere-se ao conjunto de tarefas que asseguram que o software foi criado e pode ser rastreado segundo os requisitos do cliente. A definição de V&V abrange muitas atividades de garantia da qualidade de software, sendo uma preocupação constante no desenvolvimento de software e difícil de ser obtida.

A atividade de teste, das atividades de verificação e validação, é considerada um elemento crítico para garantia da qualidade. Segundo Pressman, a distribuição recomendada de esforço em todo o processo de software é muitas vezes referida como a regra 40-20-40. Esta regra recomenda que 40% do esforço seja realizado nas fases de análise e projeto, 20% na fase de codificação e 40% realizado na fase de teste. Essa distribuição do esforço é apenas uma diretriz e varia de acordo com a natureza de cada projeto. Mas é possível observar a importância e muitas vezes as dificuldades de garantir que 40% do projeto seja utilizado para testes.

Há um conjunto de problemas comuns no processo de teste que devem ser evitados, como: cronogramas reduzidos ou inexistentes para a fase de testes; testes manuais e não controlados, gastando-se muito tempo em testes repetitivos e não eficientes; falta de recursos, ou equipe não qualificada pelo desconhecimento de ferramentas de automação de testes; falta de rastreabilidade de casos de teste entre diferentes versões do sistema, dificultando o reúso e repetição dos testes após modificações nos requisitos ou após correções; ambiente de teste diferente do ambiente de produção; ausência de critérios para seleção dos casos de teste, da definição da sua completude e do estabelecimento de um ponto de parada.

O planejamento, execução e controle de teste são dispendiosos e trabalhosos no processo de desenvolvimento de software. Com isso, as ferramentas de testes estão entre as primeiras ferramentas de software a serem utilizadas. Atualmente, essas ferramentas oferecem uma variedade de recursos que podem reduzir significativamente os problemas identificados, de modo a garantir a qualidade de software, aumentar a produtividade e diminuir os custos.

Neste livro, Rafael apresenta, de forma introdutória e objetiva, como automatizar testes utilizando duas ferramentas: JUnit e Selenium WebDriver. O autor demonstra passo a passo e com exemplos para apoiar profissionais que queiram aprender e utilizar automação de testes, melhorando a qualidade de seus softwares.
Rafael tem trabalhado com testes desde a graduação em Ciência da Computação na Universidade São Judas Tadeu. Eu, como professora dele e orientadora de Trabalho de Conclusão de Curso, pude acompanhar toda a sua trajetória, desde 2014. Seu conhecimento na área de testes e na automação de testes é vasto, e este livro é a extensão de sua experiência de trabalho diário com desenvolvimento de software, refletindo todo seu conhecimento sobre o assunto de automação de testes e ferramentas. Os profissionais que buscam orientação sobre ferramentas de automação de testes para criação de casos de testes automatizados, especialmente para Web, aprenderão como instalá-las e utilizá-las de modo a garantir maior eficiência, qualidade de software e redução de custos no desenvolvimento de software.

Dra. Ana Paula Gonçalves Serra
Coordenadora dos cursos de Análise e Desenvolvimento de Sistemas, Ciência da Computação e Sistemas de Informação da Universidade São Judas Tadeu.



Por Eschiley Mayra Rolim

A busca pela qualidade na entrega de um software tem sido constante, tornando a fase de testes fundamental.
Quando falamos em testes, uma das primeiras preocupações que aparecem são os prazos de entrega e a garantia de que uma nova versão não afetará a anterior. Desta forma, é necessário realizar os testes de regressão, que, se executados manualmente, muitas vezes são repetitivos, cansativos e demandam muito esforço. É nesse momento que podemos nos aliar à automação.

A automação de testes de software tem sido um assunto muito abordado, pois traz inúmeras vantagens para quem a utiliza, como redução de custos e prazos.
Minha primeira experiência com testes automatizados foi na faculdade, onde pude conhecer alguns conceitos e ferramentas. Posteriormente tive a oportunidade de aprender mais sobre o assunto em um curso ministrado pelo Rafael. O Selenium WebDriver é uma excelente escolha para iniciarmos a automação dos nossos testes, pois é uma ferramenta livre, gratuita e permite o uso em diferentes linguagens de programação e browsers, além de oferecer facilidades que vamos descobrir à medida que avançarmos os capítulos.

Este livro representa a experiência adquirida pelo Rafael nos últimos anos, ensinando-nos desde os conceitos básicos até a criação de scripts automatizados de uma forma clara e de fácil entendimento.


        
        

    



        
        
    
    


        
        

    SOBRE O AUTOR

    
        
        
            Rafael Peixoto Silva trabalha com qualidade de software desde 2010. Bacharel em Ciência da Computação pela Universidade São Judas Tadeu, possui certificação CTAL-TM (Certified Testers Advanced Level - Test Manager) concedido pelo BSTQB (Brazilian Software Test Qualification Board) trabalhou em grandes empresas nacionais e multinacionais principalmente nas áreas bancárias e de seguros.

Atualmente, é QA Sênior na TEx Soluções, líder em soluções online para corretoras de seguros. É responsável, entre outras atividades por desenvolver testes automatizados e garantir a qualidade na entrega de software.

Trabalhou com metodologias tradicionais e ágeis, possui experiência em treinamentos em teste de software, principalmente na área de automação.


        
        

    



        
        
    
    


        
        

    SOBRE O LIVRO

    
        
        
            Neste livro, você encontrará como escrever testes automatizados para Web utilizando Selenium WebDriver e JUnit em Java, de maneira clara e passo a passo, junto de exemplos práticos. Você verá como rodar testes automatizados em navegadores convencionais como Google Chrome e Firefox além de navegadores sem interface gráfica como HTMLUnit e Phantom JS.

A inspiração para este livro se deu pela vontade de reunir em um só um lugar o conhecimento de Selenium WebDriver adquirido durante minha carreira em testes, para os profissionais que desejam iniciar na carreira de automação de teste ou conhecer um pouco mais sobre essa ferramenta, dispondo de um material objetivo e em português.

Durante a leitura, você encontrará diversos exemplos de uso no dia a dia, conhecerá os principais problemas e dificuldades de um projeto de automação e verá padrões de projeto como Page Objects, essencial e muito requerido no mercado, que o ajudarão a escrever códigos mais limpos e de fácil manutenção. O conteúdo deste livro aborda desde a instalação e configuração de um ambiente em Java, utilizando ferramentas como o Maven, até códigos avançados de manipulação de elementos em uma página Web.

Ao longo deste livro, você também verá outras ferramentas que darão apoio à automação. Como o foco é apresentar o básico de automação com Selenium WebDriver, você não precisa ter conhecimentos prévios sobre automação de testes. Ao final, você deverá ser capaz de entender, configurar um ambiente e criar scripts de testes automatizados, bem como terá uma boa base para seguir para ferramentas e técnicas mais avançadas. 

Muitas pessoas perguntam se é necessário saber programar para poder fazer testes automatizados. Você não precisar ser um desenvolvedor sênior, mas é importante, até para uma melhor absorção do conteúdo do livro, que você tenha noção do que são os seguintes itens de programação:


	Orientação a Objetos;

	Tipos de dados/variáveis;

	Condicionais;

	Loops;

	Arrays;

	HTML (principais tags, atributos);

	CSS (conhecer os principais seletores).



Muitos testadores não gostam de programar (ou não sabem) e por isso têm um certo receio de começar a automatizar, mas vencendo esse medo, você verá que programação não é nenhum bicho de sete cabeças. Com um pouco de esforço, você conseguirá automatizar seus testes e, com certeza, vai querer começar a automatizar tudo o que puder.

As versões utilizadas neste livro são: Selenium WebDriver 3.12.0, JUnit 4.12, Faker 0.14 e Eclipse Oxygen.3a Release (4.7.3a).

Aproveite a leitura, não deixe de praticar com os exercícios e comece a automatizar seus projetos.


        
        

    



        
        
    
    


        
        

    Capítulo 1

Introdução

    
        
        
            A disciplina de testes de software está cada vez mais presente nas empresas e os motivos são muitos: entregar software funcionando para o cliente, evitar bugs em produção que podem manchar a reputação da empresa e causar prejuízos devido a software malfeito, entre outros. 

O problema é que, muitas vezes, os testes ainda são feitos exclusivamente de forma manual. Não que testes manuais não sejam importantes, pelo contrário, são extremamente valiosos, mas eles são muito lentos se compararmos com testes automatizados. Testes manuais dependem muito da habilidade do testador, que muitas vezes precisa executar os mesmos testes diversas vezes. Essa tarefa se torna cansativa, tediosa, lenta e pode fazer com que falhas passem despercebidas.

Por isso, testes automatizados são fundamentais para garantia da qualidade. Eles podem ser executados quantas vezes forem necessárias com o mesmo nível de precisão, podem ser programados para rodar em horários específicos, navegadores e sistemas operacionais diferentes e, inclusive, tudo ao mesmo tempo. Com isso, é possível ter um feedback muito mais rápido. Com os testes automatizados rodando, o testador pode aproveitar para fazer outras atividades e não se preocupar com testes repetitivos. Também é uma excelente forma de se fazer testes de regressão para validar se as novas funcionalidades não impactaram em outras que já funcionavam antes. 

É para isso que o Selenium existe. Uma ferramenta para auxiliar a criação de scripts automatizados para testes Web. É uma ferramenta open source, altamente difundida na comunidade de teste do mundo inteiro e, por isso, sempre recebe atualizações e possui suporte para as principais linguagens de programação e navegadores do mercado. Possui um código bem intuitivo e fácil de usar, o que permite que até mesmo usuários que não tenham um profundo conhecimento em programação sejam capazes de fazer testes. 

1.1 Selenium

Selenium é um framework para testes de software Web que facilita a automatização de navegadores. O projeto Selenium contém várias ferramentas para automação como Selenium IDE, Selenium Grid e WebDriver, cada uma com suas características, vantagens e desvantagens. Neste livro, você conhecerá o Selenium WebDriver, utilizando para isso a linguagem Java. Caso você não conheça essa linguagem, mas tenha conhecimento de lógica de programação ou conheça outras linguagens de programação, não se preocupe, porque os seus testes de Selenium também podem ser desenvolvidos em outras linguagens. 

Para você que deseja começar no mundo da automatização de testes, o Selenium é uma excelente maneira de começar a entender esse tipo de teste. Muitos outros frameworks de testes, inclusive, utilizam o WebDriver como base, o que faz com que o conhecimento nessa ferramenta seja essencial. Um exemplo disso é o Protractor, um framework de automação de sistemas feitos com Angular, que utiliza o Selenium WebDriver Js (versão do WebDriver para JavaScript).

É muito comum que as empresas ou até mesmo os profissionais que desejam iniciar na área de automatização de testes optem por ferramentas do tipo record and playback. Essas ferramentas consistem basicamente em gravar as ações do usuários para que sejam reproduzidas posteriormente. Essa escolha dá-se porque muitas vezes as companhias não possuem profissionais com perfil de programação, não possuem tempo para treiná-los ou dinheiro para contratar no mercado. 
Um bom exemplo é o Selenium IDE. Parece uma opção milagrosa e salvadora no início, mas existem algumas limitações. Esse tipo de ferramenta deixa de ser vantajoso à medida que seus casos de testes começam a aumentar e a manutenção começa a ser custosa. Outro ponto é que mesmo ferramentas de gravação, muitas vezes, precisam de ajustes, o que torna o mínimo conhecimento em programação necessário.

É analisando esse cenário que o Selenium WebDriver se torna uma excelente saída. Por mais que exista uma curva de aprendizado da API (e da linguagem de programação, caso você não tenha), o WebDriver possui uma API simples e objetiva. Possui suporte para todos os principais navegadores do mercado como Google Chrome, Firefox, Internet Explorer e Safari, pode ser escrito nas principais linguagens de programação atuais tais como Java, Python, Ruby, JavaScript e C#. Além disso, permite integração com outras ferramentas bastante conhecidas no mercado de testes como o TestLink e Mantis, por exemplo. Com o uso de padrões como Page Objects, sua leitura e a manutenção do código torna-se ainda mais simples. 

É uma ferramenta bastante difundida na comunidade de testes do mundo, o que faz com que sempre tenha atualizações com melhorias, correções, e possibilita que seja muito fácil encontrar material de apoio. Tudo isso em uma ferramenta open source.

Por ser possível utilizar o Selenium em várias linguagens de programação de sua preferência, você ainda pode combinar os recursos da API do Selenium com outros recursos próprios da linguagem como desvios condicionais, loops, relatórios entre outros recursos e bibliotecas que podem tornar nossos testes ainda mais robustos e poderosos. 
É hora de botar a mão na massa, preparar nosso ambiente e escrever nossos testes. É um caminho sem volta: uma vez que você começar a automatizar, vai querer automatizar o mundo.

Bem-vindo ao mundo da automatização de software.


        
        

    



        
        
    
    


        
        

    Capítulo 2

Instalando o Selenium

    
        
        
            Antes de começarmos a instalação do Selenium propriamente dito, temos alguns outros passos antes. Neste livro, vamos trabalhar o Selenium com Java então é um pré-requisito a instalação do Java e do JDK (Java Development Kit). Além disso, a IDE escolhida para este livro é o Eclipse, por ser uma ferramenta gratuita e uma das mais utilizadas no mercado.

Caso você não tenha nenhum destes instalado na sua máquina, você pode fazer o download:


	Java: https://www.java.com/pt_BR/download/.

	JDK: http://www.oracle.com/technetwork/pt/java/javase/downloads/index.html


	Eclipse: https://www.eclipse.org/downloads/?




A instalação destes softwares é simples, basta seguir o padrão "NEXT > NEXT > FINISH". Caso você tenha alguma dificuldade na instalação, nas páginas de download, você pode visualizar tutoriais de ajuda.

A instalação do Selenium pode ocorrer de duas formas. Primeiro veremos a instalação com o download dos arquivos .jar e depois utilizando o Maven.

2.1 Configurando o Selenium no Eclipse

Como dito anteriormente, a primeira maneira que veremos de preparar o Selenium no seu projeto é através de um arquivo .jar. Para isso, precisamos fazer o download em: 


http://www.seleniumhq.org/download/






[image: Opções de download da página do Selenium para várias linguagens]Figura 2.1: Opções de download da página do Selenium para várias linguagens



Depois que o download for concluído, descompacte-o em um local de sua preferência, vá até o Eclipse para configurá-lo conforme os passos a seguir:


	Crie um projeto
Vá em File > New > Java Project.






[image: Criando um projeto Java]Figura 2.2: Criando um projeto Java



Digite um nome para o seu projeto, o local em que você armazenará o projeto: 




[image: Definindo um nome e o local para salvar o projeto.]Figura 2.3: Definindo um nome e o local para salvar o projeto.



Clique em Finish e logo em seguida em Yes. Aparecerá no canto o nosso projeto criado conforme imagem a seguir:




[image: Projeto Java criado.]Figura 2.4: Projeto Java criado.




	Adicione o Selenium ao seu projeto.



Clique com o botão direito do mouse no seu projeto recém-criado > Build Path > Configure Build Path.




[image: Caminho para configuração de build path.]Figura 2.5: Caminho para configuração de build path.



Na janela que aparece a seguir, clique na aba Libraries.




[image: Configurando caminho de configuração.]Figura 2.6: Configurando caminho de configuração.



Clique em Add External JARs..., vá até o diretório que contém o jar do Selenium. Você verá que o arquivo baixado conterá a seguinte estrutura de pasta e arquivos:

selenium-java-3.8.1
├── CHANGELOG
├── client-combined-3.8.1.jar
├── client-combined-3.8.1-sources.jar
├── libs
│   ├── byte-buddy-1.7.5.jar
│   ├── commons-codec-1.10.jar
│   ├── commons-exec-1.3.jar
│   ├── commons-logging-1.2.jar
│   ├── gson-2.8.2.jar
│   ├── guava-23.0.jar
│   ├── httpclient-4.5.3.jar
│   └── httpcore-4.4.6.jar
├── LICENSE
└── NOTICE


Vamos adicionar o arquivo client-combined-3.8.1.jar e todos os jars dentro da pasta libs.

Clique em Add Library..., escolha o JUnit > Next > Finish.

Pronto!




[image: Adicionando jars ao build path]Figura 2.7: Adicionando jars ao build path



Clique em OK e seu projeto agora conterá todos os jars do Selenium e JUnit.




[image: Jars adicionados ao build path]Figura 2.8: Jars adicionados ao build path



Nosso projeto está pronto!


Dependendo da versão que você baixar, pode haver diferenças nos arquivos jar apresentado nas imagens anteriores, não se preocupe. Na dúvida, você pode importar todos os arquivos que vierem no seu download sem problemas.



2.2 Maven

Uma opção mais fácil e, na minha opinião, muito melhor, é utilizar o Maven e adicionar as dependências do seu projeto. O Maven é uma ferramenta de gerenciamento, construção e implantação de projetos que ajuda no processo de gerenciamento de dependências e build, geração de relatórios e de documentação. 

Assim, não precisamos nos preocupar em fazer o download do Selenium (e outras bibliotecas), vamos apenas buscar essas dependências e adicioná-las no pom.xml (o arquivo que fará esse gerenciamento para nós). Neste nosso caso, vamos adicionar as dependências do Selenium e do JUnit. 

Caso você não possua o Maven na sua máquina, você pode fazer o download em: https://maven.apache.org/download.cgi. Aqui o foco não é mostrar a instalação do Maven, então, até para facilitar, você pode fazer o download das versões mais atuais do Eclipse que já contêm o Maven.

Como o Maven instalado, vamos criar um projeto. Clique em File > New > Maven Project (caso a opção Maven Project não esteja visível, você pode clicar em Other... e na caixa que abrirá encontrar a opção Maven Project).




[image: Criando um Maven Project]Figura 2.9: Criando um Maven Project



Vamos selecionar a opção Create a simple project (skip archtype selection). Você ainda pode escolher o local do seu workspace ou deixar o padrão.




[image: Definindo o local do projeto Maven]Figura 2.10: Definindo o local do projeto Maven



Clique em Next. Vamos preencher Group Id, Artifact Id e manter o Packaging como jar mesmo.




[image: Configurando a estrutura do Maven]Figura 2.11: Configurando a estrutura do Maven



Clique em Finish e o projeto será criado conforme imagem a seguir:




[image: Visão das pastas criadas pelo Maven]Figura 2.12: Visão das pastas criadas pelo Maven



O Maven, além de organizar as pastas do nosso projeto, também já cria um arquivo na raiz do projeto: o pom.xml. Esse pom.xml já vem com as configurações iniciais. O seu pom.xml padrão deve ser assim:

<project xmlns="http://maven.apache.org/POM/4.0.0" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:schemaLocation="http://maven.apache.org/POM/4.0.0 http://maven.apache.org/xsd/maven-4.0.0.xsd">
  <modelVersion>4.0.0</modelVersion>
  <groupId>br.com.aprendendo-selenium</groupId>
  <artifactId>aprendendo_selenium</artifactId>
  <version>0.0.1-SNAPSHOT</version>
</project>


Nós precisamos incluir as dependências que utilizaremos em nosso projeto. No nosso caso, vamos adicionar o Selenium e o JUnit. Essas dependências devem ser incluídas logo após a tag <version>. 

<project xmlns="http://maven.apache.org/POM/4.0.0" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
    xsi:schemaLocation="http://maven.apache.org/POM/4.0.0 http://maven.apache.org/xsd/maven-4.0.0.xsd">
    <modelVersion>4.0.0</modelVersion>
    <groupId>br.com.aprendendo-selenium</groupId>
    <artifactId>aprendendo_selenium</artifactId>
    <version>0.0.1-SNAPSHOT</version>
    <dependencies>
        <dependency>
            <groupId>org.seleniumhq.selenium</groupId>
            <artifactId>selenium-java</artifactId>
            <version>3.4.0</version>
        </dependency>
        <dependency>
            <groupId>junit</groupId>
            <artifactId>junit</artifactId>
            <version>4.12</version>
        </dependency>
    </dependencies>
</project>


Repare que cada uma das dependências possui uma tag <version>, que indica qual a versão que vamos usar. No momento em que o livro foi escrito, as versões eram as descritas no código. Você não precisa se preocupar em decorar todos esses códigos das dependências. Sempre que precisar adicionar uma nova dependência ou atualizar a versão de alguma já existente, você pode acessar https://mvnrepository.com/ e procurar pela dependência que deseja usar. No geral, é bom utilizarmos sempre a última versão de cada dependência para termos sempre as últimas melhorias e correções, mas tome cuidado: às vezes, ao atualizar uma dependência, podemos gerar incompatibilidade com outras dependências. Sempre verifique isso!

2.3 Conclusão

Finalizamos aqui a parte de instalação e configurações básicas. Com isso, já temos o necessário para começarmos a desenvolver nossos testes. O funcionamento do projeto será o mesmo independentemente de você escolher a instalação dos jars manualmente ou utilizando o Maven, mas aconselho fortemente que você opte por utilizar este último. É muito mais fácil de configurar e sempre que uma nova versão estiver disponível basta que nós alteremos a sua dependência, que o Maven vai atualizar e baixar os jars necessários para nós automaticamente. 

Agora que já configuramos nosso ambiente, no próximo capítulo vamos conhecer um pouco do JUnit, que será uma base importante para os nossos scripts, suas principais annotations e seu uso em diferentes momentos dos testes.


        
        

    



        
        
    
    


        
        

    Capítulo 3

JUnit

    
        
        
            Antes de começarmos a falar de códigos do WebDriver, é importante conhecermos um pouco mais sobre o JUnit, já que é ele que vai executar nossos testes, apresentar resultados e nos ajudar com algumas configurações importantes.

Ao longo deste capítulo, conheceremos as principais utilidades do JUnit para nossos testes. Se você já trabalha em uma empresa que desenvolve software com Java e os desenvolvedores costumam fazer testes unitários, é muito provável que eles utilizem o JUnit, pois é o framework de teste mais conhecido e utilizado no mercado. Existem outros frameworks com essa finalidade em Java, como o TestNG, que também é uma boa opção, mas neste livro vamos tratar apenas do JUnit, pois atende bem as nossas necessidades.

Assim como em testes manuais, nós precisamos nos atentar e preparar nossos testes com configurações importantes, bem como pré e pós-condições, steps (passos) e validação (resultado esperado). Inicialmente vamos conhecer as principais anotações de JUnit para criar apenas as pré e pós-condições além, é claro, dos nossos casos de teste, e nos próximos capítulos veremos como de fato validar os resultados dos testes. 

O JUnit possui algumas anotações que nos ajudam a marcar nosso código diferenciando nossos métodos para cada fase de um teste. Por exemplo, temos marcações para definir quais serão as pré-condições. Existem também marcações para dizer quais os métodos que serão os nossos testes de fato. Essas marcações deixam bem claro no nosso código cada etapa e, utilizando o JUnit, nós não precisaremos mais utilizar o método main. O próprio JUnit vai executar e, inclusive, gerar de forma bem visual um relatório com os testes que passaram e falharam.

3.1 @BeforeClass

A primeira anotação que vamos ver é a @BeforeClass. O método que tiver essa anotação será executado apenas uma vez e será sempre o primeiro de todos. Por esse motivo, é muito comum que ele seja utilizado para métodos com pré-condições, como iniciar o browser e acessar a URL da página que será testada.

Uma característica importante é que o método com essa anotação deve ser estático. Veja um exemplo da declaração de um método com o @BeforeClass:


Por enquanto, não vamos nos preocupar com os imports, vou mostrá-los mais para a frente.



@BeforeClass
public static void beforeClass() {
    // seu código aqui
}


Tanto para essa anotação quanto para as demais que veremos ainda neste capítulo, o nome do método não faz diferença e pode ser alterado conforme sua preferência, logo, o exemplo a seguir terá o mesmo comportamento do código anterior:

@BeforeClass
public static void nomeDoMeuMetodo() {
    // seu código aqui
}


Dentro deste método, você pode colocar as suas pré-condições, ou seja, tudo aquilo que deve ser executado antes do teste. É como preparar o terreno para que ele esteja nas condições ideais para o teste.

@Before

Muito parecido com o @BeforeClass, mas com algumas particularidades: os métodos com essa anotação são executados uma vez antes de cada @Test (veremos em seguida). Ou seja, a quantidade de vezes que ele é executado depende também da quantidade de @Test que teremos. Podemos utilizá-lo para algumas condições antes de cada caso de teste. Por exemplo: recarregar a página antes de cada teste.

@Before
public void before() {
   // seu código aqui
}


Não confunda @Before com o @BeforeClass. O @BeforeClass é sempre o primeiro de todos e executado apenas uma vez, enquanto o @Before pode ser executado mais de uma vez em decorrência da quantidade de testes que tivermos.

@Test

Os métodos com @Test seriam os nossos casos de teste, ou seja, eles vão executar os passos necessários e validar se os resultados estão de acordo com o esperado.

@Test
public void test() {
    // seu código aqui
}


@After

Tem o mesmo funcionamento do @Before com uma diferença importante: ele é executado depois de cada @Test.

@After
public void after() {
    // seu código aqui
}


@AfterClass

E por fim temos o @AfterClass, que, seguindo com a lógica dos anteriores, é executado por último uma única vez e também precisa ser estático.

@AfterClass
public static void afterClass() {
    // seu código aqui
}


3.2 Exemplo prático

O JUnit ainda oferece outros recursos que serão apresentados ao longo deste livro, mas que por ora não são relevantes. Para entendermos o funcionamento dessas anotações, vamos criar uma classe e ver o que acontece na prática. 
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